
Georeferencing a scanned map with OkMap 13/11/2021

A scanned map, like a photograph, is a rectangular array of pixels.

In this example it measures 2550 pixels wide by 3510 pixels high.

Computers give individual pixels a pair of coordinates measured 
across and down from the top left hand corner.

Here the centre of the bridge across the Avonmore at Annamoe
has pixel coordinates (1935, 2215)

However the Irish Grid coordinates of this point are measured 
across and up and are 

        (E 317289, N 199232)

These are in metres measured 
from an origin in the Atlantic
off the South-West
coast.

In order for the computer to display the coordinates of any point in the Irish Grid form a conversion formula
is needed.

The process of calculating and saving this formula is called georeferencing. It can be done using OkMap 
Desktop. You must have the full version to do what follows.

You will need to have created a file of a scanned image of a paper map to work with. 

File extensions
Scanned maps will be stored in files with extension of either .jpg or .png.  
Files with these extensions are raster files which means they consists of an array of pixels.
OkMap can deal with either type but in the examples that follow .jpg is used

Georeferencing conversion formulae for use with OkMap are stored in files with the extension .okm. These 
are text files. 

It is a good idea to set up File Explorer so as to show the full file names, including their extensions, and all 
the details about the file rather than just an icon.
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First click on the View tab
Click on Details

Tick the File name extensions box

Georeferencing

Run OkMap and, in the Home tab, first load
your .jpg raster file by going to  

File  >  New  >  Raster Map 

and then, using the resultant New map window, find and open your image file, Mymap.jpg  say

It will appear shortly

To the right of the map image is the Map Calibration window. You will probably need to widen this window 
to see everything.
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Click on Map Setup and type in a name [you can just leave this blank] before clicking on Next.

After a considerable pause (be patient !) this will bring up the Select projection and datum screen.

If you click on                                                                                                                                                      you will be
presented with a huge number of options.

To reduce this to a manageable number you can filter the options by Area and type in the word Ireland 
(more patience required !) you will now get six options of which TM65 / Irish Grid should be selected.

A better way to bring up this option by itself is to filter by EPSG code.

Type in the code 29902 (patience, again) to get the single option  TM65 / Irish Grid to select.

On the resultant screen click on OK. 
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[Other projections will be needed for UK and European maps - see Note 2 below]

Click on Grid setup and make the East/North grid intervals 1.000m i.e.  what we would write as 1,000m 
which is 1km.

Have your paper map to hand. To calibrate the scanned map you will now need to
select three points at grid-line intersections and forming as large a triangle as you 
can for best accuracy.

For these three points make a note from your paper map of their coordinates. These can either be 6-digit or
letter + 5-digit coordinates.  Paper maps should have the full 6-digits for the grid lines at each corner but 
may omit the first digit for other grid lines.

An explanation of the relationship between the OSI letter + 5-digit and its 6-digit equivalent can be found in
Note 1 below.

NB The notation used in the Rambler is letter + 3-digit  which gives an accuracy to within 100m.

Calibrating
Mark the first of the three points chosen as a grid reference as follows:

Zoom in close to the first point and, in the Home tab,
select the bright blue cross-hair icon to mark a

 New georeference point

The cursor will change from an arrow to a cross. Move it across to your point and click.
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The point will be marked with a blue
cross in a black square and a number

Now in the Map Calibration window click on Add, click again on 
the bright blue dotted cross-hair and place the next point.

Repeat for the third point

Don’t worry about getting the points on exact grid-line 
intersections – they can be nudged into positions later.

Now, in the Map Calibration window, go to the Point 
box and click on 3 , say. 

Zoom in onto this point so that it takes up a large part 
of the screen.

If the cross-hair is not exactly in the centre of the grid-line intersection then nudge it into place using the 
blue arrows in the Adjust point  area [clicking on one of the blue circles will move the point to one of the 
corners or the centre - not what you want].
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Now enter the coordinates of the point, making sure that you have first selected the Irish Grid reference 
system [IG] or the 6-figure reference form [Metric]

Repeat this for points 1 and 2. 

Then, and only then click the Accept button at the
bottom of the Map Calibration window.  

A North pointing arrow will appear on the map and the georeferenced grid lines will appear in red. The 
colour and width of the lies can be changed in the Grid tab in Preferences  [        ]

If they don't appear go to the View tab and check the Metric grid box

These red grid lines should
coincide reasonably well with
the grid lines of the map.

It's very unlikely that this will
be the case everywhere - it
will depend on the state of
the map when it was scanned
and the quality of the scan.

If this clearly isn’t the case then the coordinates of one or more of the three points are incorrect.

The data for the three calibration points 
can be modified by going to the
Management tab and clicking on
Map parameters
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You can then check/change the values for each point before clicking the Accept button.

Note: It may seem that OkMap has changed your original values but this is only a rounding error.

e.g. here 03995 rounds to 04000

You can also check by clicking on Cursor at the bottom left-hand corner of the screen [between General 
and Map] and checking that the georeferencing is correct by moving the cursor arrow onto a known grid-
line intersection. The coordinates will be shown at the bottom of the screen in Irish grid form. 

Finally go to
  
File  >  Save  >  Save map 

and accept the default file name (the
same as the .jpg file used but with the
extension .okm).

At a later time this georeferenced map can be reloaded by going to File  >  Load  >  Map and clicking on the 
required .okm file. This will load the associated .jpg file and set up the georeferencing ready for your use.

Note: both Mymap.jpg and Mymap.okm files must be in the same folder for everything to work. 

To send a georeferenced map to someone both files must be included. Since the files are likely to be large 
you may find that you cannot send them as email attachments. In this case consider using the free version 
of  WeTransfer [https://wetransfer.com]
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 Note 1:  6-figure coordinates and OSI lettered references

On an OSI map the 6-figure grid references are given
for the points at the corners of the map. These will
help you to decide what the 6-figure reference for any
other point will be. Otherwise it can be calculated as
follows. 

In the national grid, Ireland is described as a square
500 km by 500 km.  This is further divided into 25
squares, each of which is of side 100km and each of
which is given a letter. 

Converting from an OSI lettered reference to a six-
figure reference
Taking a scale of 100km = 1 unit the bottom left-hand
corner of each square has coordinates such as:
V(0,0) W(1,0)         R(1,1)     H(2,3)

The OSI squares in the Wicklow area are

N (2,2)   O (3,2)    S (2,1)     T (3,1). 

The Rambler letter + 3-digit grid reference is converted to the OSI letter + 5-digit form by adding two 
zeroes after each of the two numbers.
Then the numerals given above for the letter are placed in front of the numbers.

So, for example, a reference: O: 120 140  would translate [using O (3,2)] as follows:  

 Rambler form   OSI letter + 5-digit form 6-figure form

O: 120 140   O: 12000 14000  312000 E   214000 N
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Note 2:  Georeferencing UK and European maps
Maps of Northern Ireland use the same Irish Grid Projection with Ireland 1965 Datum as OSi maps but 
elsewhere you will use different choices for Projection/Datum

The most commonly required projections and datums are given below. 

Projection / datum EPSG code

ED59 / UTM Zone 28N 23028

ED59 / UTM Zone 29N 23029

ED59 / UTM Zone 30N 23030

ED59 / UTM Zone 31N 23031

TM65 / Irish Grid 29902

OSGB36 / British National Grid 27700

WGS84 / UTM 28N 32628

WGS84 / UTM 32N 32632

WGS84 / UTM 33N 32633

UK maps
For UK maps you should choose the OSGB36 / British National Grid projection /  datum.
It is a similar system to the OSI and grid references can be entered as either a  6-digit number or two letters
+ 5-digits 

European maps
Most European maps use the UTM [Universal
Transverse Mercator] format. 
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You will need to check the paper map to find
the Projection and the Datum

In this case, a map of part of Austria, the projection is  UTM 33T and the datum is the most common one 
WGS84  [World Geodetic System 1984]

In OkMap the system is simplified and only the UTM number is used together with the letters N or S [N/S of 
the equator]    e.g. zones 33S, 33T and 33U would all be simply UTM zone 33N

So for this map you would need to choose the projection / datum WGS84 / UTM zone 33N in OkMap. 

You will find that the UTM coordinates of points are usually  6-digits East  but  7-digits North

Note: In Spain/Portugal maps may have a Datum of ED-50 [short for European Datum 1950] in which case 
choose  ED50 / UTM zone 29N  or  ED50 / UTM zone 30N or  ED50 / UTM zone 31N

Usually maps will have 1km grids but you may come across coordinates given in degrees and minutes with 
1' grids. In this case, when you are in Grid setup you should change the  Lon. / Lat. grid intervals to 1'  
before clicking on Copy from map

Checking the georeferencing
To check your georeferencing first create a .gpx track on your map in OkMap and save it.

Go to All things GPS/GPX on the website and use GPX Local view to check that it appears correctly there.
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Note 3:  Changing the name of a .okm file
It is probably best to keep the names of any .okm file and its associated .jpg file the same except for the file 
extensions.

If you had two such files called, for example, Camaderry.okm and Camaderry.jpg and changed the names 
to Brockaghs.okm and Brockaghs.jpg using File Explorer you would get an error message when you tried to 
load Brockaghs.okm in OkMap.

This is because the .okm file contains the name of the .jpg file that it uses and that has now been changed.

To fix this problem the appropriate line in the .okm file must be edited to give the new file name.

To do this open Windows Notepad
(or any other text editor) and load 
Camaderry.okm

You will see that this is just an
ordinary .txt file. About 8 lines 
down you should find the line:

<filename>Camaderry.jpg</filename>

change this line to
<filename>Brockaghs.jpg</filename>

and save the file as a .txt file called  Brockaghs.okm
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<?xml version="1.0" encoding="utf-8"?>
<map xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" version="1.1" 
creator="OkMap 10.11.3" 
xmlns="http://www.okmap.it/xsd/map/1/1">
  <metadata>
    <name />
    <desc />
    <bounds minlat="52.8880747386594" minlon="-
6.62325646442613" maxlat="53.0731808238685" maxlon="-
6.23631902057385" />
  </metadata>
  <filename>Camaderry.jpg</filename>
  <size>
    <width>10065</width>
    <height>7898</height>
  </size>
  <projectionPredef>Irish Grid</projectionPredef>
  <datum>Ireland 1965 (Ireland)</datum>
  <proj>
    <name>Transverse Mercator</name>
  ..........
  ..........


